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Survey Analysis Workshop                                             Copyright 2014   John F Hall 

Data sets and documents used for tutorials and exercises 

Commentary on SPSS files for Babbie et al    [Draft only: 15 Jan 2014] 

 
Earl Babbie, Fred S. Halley, William E Wagner III and Jeanne Zaino 
Adventures in Social Research: Data Analysis Using IBM SPSS Statistics  
(8th edition, Sage 2013) 
  
[Extract from page Highly recommended SPSS textbooks] 

 
"An excellent book with a companion website and comprehensive coverage of the survey research 
process and logic of analysis as well as SPSS: very student- and user-friendly, especially for beginners, 
and encourages co-operative working.  Uses SPSS 19/20 with data from the 2008 General Social 
Survey but with GUI, not syntax.  There is a companion website with support materials for students." 
 
This book is large format and heavy: it will easily slide off your knee.  You will need plenty of desk space!   
It is pre-punched with 3 holes, and the pages are perforated at the binding, to enable breaking it up into 
smaller sections to store in a ledger file.   
 
It uses IBM® SPSS® Statistics releases 18 and 19+: I am currently using release 22.  All the examples 
use the drop-down menus in the GUI: there are no examples using SPSS syntax.  Gradpack supports 
syntax, but the Student Version does not (it is owned by Prentice-Hall and is only available bundled with 
certain textbooks).   
 
Three SPSS saved files used in the book are described in Appendix A pp 387 – 398: 
 
Demo.sav  (32 variables) 
Exer.sav (35 variables) 
Vars common to both (12 variables, but no file name) 
 
The questions used are listed for each, but also there is also another "Questionnaire for Class Survey" 
(in traditional questionnaire format) in Appendix B pp399 – 405, but the variables are not in the same 
order. 
 
Since I couldn't access the supporting materials via the Sage site, I spent a whole day re-creating SPSS 
files and documentation.  Working directly from Appendix A in the book, and using the original 
GSS2008.sav from Roper, I used SPSS syntax to extract the variables specified for each and save new 

files keeping the variables in the order specified. 
 
babbie_demo.sav 
babbie_exer.sav 
babbie_common.sav  
  
. . and also a merged file containing all variables from the above: 
 
babbie_all.sav 
 
I generated three SPSS files with variables in the same order as in the book, but it's not clear if this is the 
same order as the actual questionnaire used in the field.  The book says the variables in my 
babbie_common.sav are included in their versions of demo.sav and exer.sav, but since I couldn't 

http://surveyresearch.weebly.com/babbie-halley-wagner-and-zaino-2013.html
http://surveyresearch.weebly.com/highly-recommended-spss-textbooks.html
http://www-01.ibm.com/software/analytics/spss/products/statistics/gradpack/
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/student_version_limitation_list.pdf
http://www.pearsonhighered.com/educator/product/IBM-SPSSreg-180-Integrated-Student-Version/9780132151719.page
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access the student or instructor site, I kept them separate.  The files were created using the following 
syntax: 
   

title 'Recreate samples for Babbie et al'. 
 
/* demo.sav. 
SAVE OUTFILE= 
   'C:\Users\John\Desktop\Surveys\NORC General Social Survey\babbie_demo.sav' 
   /keep abany abdefect to abpoor abrape to absingle 
       chldidel marital divorce childs 
       obey popular thnkself workhard helpoth 
      sibs attend postlife pray relig cappun getahead  
      homosex xmovie premarsx gunlaw racdif4 marblk natrace. 
display labels. 
 
/* exer.sav. 
SAVE OUTFILE= 
   'C:\Users\John\Desktop\Surveys\NORC General Social Survey\babbie_exer.sav' 
   /keep  
      fechld fepresch fefam fehire health  
      polhitok polabuse polmurdr polescap  
      polattak news tvhours conpress contv  
      natheal natcity natcrime natdrug nateduc natrace natfare  
      pillok sexeduc teensex  
      affrmact wrkwayup racwork discaff 
      eqwlth eff911f eff911k eff911l eff911m 
      region vote04. 
display labels. 
 
/* vars common to both. 
SAVE OUTFILE= 
   'C:\Users\John\Desktop\Surveys\NORC General Social Survey\babbie_common.sav' 
   /keep  
      id age class educ  
      polviews partyid income sei  
      race rincome sex . 
display labels. 

 
These files were then combined into a single composite file babbie_all.sav using the SPSS command:  

 
 match files ~ ~ ~ ~. 
 
SPSS saved file GSS2008.sav has most variable names in lower case and most variable and value 

labels in UPPER CASE.  My practice when opening such files is to modify them to change all labels to 
Mixed Case (See commentaries on SPSS files on my site).  Many of these files also need missing 
values and measurement levels to be specified.  GSS2008 missing values have all been declared and 
are consistently labelled, but measurement levels, although they appear to have been specified, are 
actually automatically created by SPSS and are not correct.  They need to be correctly specified by the 
user. 
 
All variable and value labels in these files were in UPPER CASE, which I find unaesthetic, so I changed 
them all to Mixed Case using Python code supplied by Jon Peck (Senior Software Engineer, IBM/SPSS) 
and saved the new file as: 
 
babbie_all2.sav 
 

http://surveyresearch.weebly.com/data-sets-and-documents-used-in-tutorials-and-exercises.html
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babbie_demo.sav 

 
Variable Labels 

Variable Position Label 

abany 1 ABORTION IF WOMAN WANTS FOR ANY REASON 
abdefect 2 STRONG CHANCE OF SERIOUS DEFECT 
abhlth 3 WOMANS HEALTH SERIOUSLY ENDANGERED 
abnomore 4 MARRIED--WANTS NO MORE CHILDREN 
abpoor 5 LOW INCOME--CANT AFFORD MORE CHILDREN 
abrape 6 PREGNANT AS RESULT OF RAPE 
absingle 7 NOT MARRIED 
chldidel 8 IDEAL NUMBER OF CHILDREN 
marital 9 MARITAL STATUS 
divorce 10 EVER BEEN DIVORCED OR SEPARATED 
childs 11 NUMBER OF CHILDREN 
obey 12 TO OBEY 
popular 13 TO BE WELL LIKED OR POPULAR 
thnkself 14 TO THINK FOR ONES SELF 
workhard 15 TO WORK HARD 
helpoth 16 TO HELP OTHERS 
sibs 17 NUMBER OF BROTHERS AND SISTERS 
attend 18 HOW OFTEN R ATTENDS RELIGIOUS SERVICES 
postlife 19 BELIEF IN LIFE AFTER DEATH 
pray 20 HOW OFTEN DOES R PRAY 
relig 21 RS RELIGIOUS PREFERENCE 
cappun 22 FAVOR OR OPPOSE DEATH PENALTY FOR MURDER 
getahead 23 OPINION OF HOW PEOPLE GET AHEAD 
homosex 24 HOMOSEXUAL SEX RELATIONS 
xmovie 25 SEEN X-RATED MOVIE IN LAST YEAR 
premarsx 26 SEX BEFORE MARRIAGE 
gunlaw 27 FAVOR OR OPPOSE GUN PERMITS 
racdif4 28 DIFFERENCES DUE TO LACK OF WILL 
marblk 29 CLOSE RELATIVE MARRY BLACK 
natrace 30 IMPROVING THE CONDITIONS OF BLACKS 

Variables in the working file 

 
[NB:  Need to check if this is the file distributed with SPSS] 
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babbie_exer.sav 
 

Variable Labels 

Variable Position Label 

fechld 1 MOTHER WORKING DOESNT HURT CHILDREN 
fepresch 2 PRESCHOOL KIDS SUFFER IF MOTHER WORKS 
fefam 3 BETTER FOR MAN TO WORK, WOMAN TEND HOME 
fehire 4 SHOULD HIRE AND PROMOTE WOMEN 
health 5 CONDITION OF HEALTH 
polhitok 6 EVER APPROVE OF POLICE STRIKING CITIZEN 
polabuse 7 CITIZEN SAID VULGAR OR OBSCENE THINGS 
polmurdr 8 CITIZEN QUESTIONED AS MURDER SUSPECT 
polescap 9 CITIZEN ATTEMPTING TO ESCAPE CUSTODY 
polattak 10 CITIZEN ATTACKING POLICEMAN WITH FISTS 
news 11 HOW OFTEN DOES R READ NEWSPAPER 
tvhours 12 HOURS PER DAY WATCHING TV 
conpress 13 CONFIDENCE IN PRESS 
contv 14 CONFIDENCE IN TELEVISION 
natheal 15 IMPROVING & PROTECTING NATIONS HEALTH 
natcity 16 SOLVING PROBLEMS OF BIG CITIES 
natcrime 17 HALTING RISING CRIME RATE 
natdrug 18 DEALING WITH DRUG ADDICTION 
nateduc 19 IMPROVING NATIONS EDUCATION SYSTEM 
natrace 20 IMPROVING THE CONDITIONS OF BLACKS 
natfare 21 WELFARE 
pillok 22 BIRTH CONTROL TO TEENAGERS 14-16 
sexeduc 23 SEX EDUCATION IN PUBLIC SCHOOLS 
teensex 24 SEX BEFORE MARRIAGE -- TEENS 14-16 
affrmact 25 FAVOR PREFERENCE IN HIRING BLACKS 
wrkwayup 26 BLACKS OVERCOME PREJUDICE WITHOUT FAVORS 
racwork 27 RACIAL MAKEUP OF WORKPLACE 
discaff 28 WHITES HURT BY AFF. ACTION 
eqwlth 29 SHOULD GOVT REDUCE INCOME DIFFERENCES 
EFF911F 30 HOW EFFECTIVE R THINKS REDUCING AIR TRAVEL 
EFF911K 31 HOW EFFECTIVE R THINKS AVOIDING TRAVEL TO CERTAIN CITIES 
EFF911L 32 HOW EFFECTIVE R THINKS AVOIDING TALL BUILDINGS 
EFF911M 33 HOW EFFECTIVE R THINKS AVOIDING NATIONAL LANDMARKS 
region 34 REGION OF INTERVIEW 
vote04 35 DID R VOTE IN 2004 ELECTION 

Variables in the working file 

 
babbie_common.sav 

Variable Labels 

Variable Position Label 

id 1 RESPONDNT ID NUMBER 
age 2 AGE OF RESPONDENT 
class 3 SUBJECTIVE CLASS IDENTIFICATION 
educ 4 HIGHEST YEAR OF SCHOOL COMPLETED 
polviews 5 THINK OF SELF AS LIBERAL OR CONSERVATIVE 
partyid 6 POLITICAL PARTY AFFILIATION 
income 7 TOTAL FAMILY INCOME 
sei 8 RESPONDENT SOCIOECONOMIC INDEX 
race 9 RACE OF RESPONDENT 
rincome 10 RESPONDENTS INCOME 
sex 11 RESPONDENTS SEX 

Variables in the working file 

 
[NB:  The variable wt2008nr is not in file GSS2008.sav, but is in exer.sav] 
 
I can now MATCH my three files and save them as babbie_all.sav with variables in this order: 
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Variable Labels 

Variable Position Label 

id 1 RESPONDNT ID NUMBER 
abany 2 ABORTION IF WOMAN WANTS FOR ANY REASON 
abdefect 3 STRONG CHANCE OF SERIOUS DEFECT 
abhlth 4 WOMANS HEALTH SERIOUSLY ENDANGERED 
abnomore 5 MARRIED--WANTS NO MORE CHILDREN 
abpoor 6 LOW INCOME--CANT AFFORD MORE CHILDREN 
abrape 7 PREGNANT AS RESULT OF RAPE 
absingle 8 NOT MARRIED 
chldidel 9 IDEAL NUMBER OF CHILDREN 
marital 10 MARITAL STATUS 
divorce 11 EVER BEEN DIVORCED OR SEPARATED 
childs 12 NUMBER OF CHILDREN 
obey 13 TO OBEY 
popular 14 TO BE WELL LIKED OR POPULAR 
thnkself 15 TO THINK FOR ONES SELF 
workhard 16 TO WORK HARD 
helpoth 17 TO HELP OTHERS 
sibs 18 NUMBER OF BROTHERS AND SISTERS 
attend 19 HOW OFTEN R ATTENDS RELIGIOUS SERVICES 
postlife 20 BELIEF IN LIFE AFTER DEATH 
pray 21 HOW OFTEN DOES R PRAY 
relig 22 RS RELIGIOUS PREFERENCE 
cappun 23 FAVOR OR OPPOSE DEATH PENALTY FOR MURDER 

getahead 24 OPINION OF HOW PEOPLE GET AHEAD 
homosex 25 HOMOSEXUAL SEX RELATIONS 
xmovie 26 SEEN X-RATED MOVIE IN LAST YEAR 
premarsx 27 SEX BEFORE MARRIAGE 
gunlaw 28 FAVOR OR OPPOSE GUN PERMITS 
racdif4 29 DIFFERENCES DUE TO LACK OF WILL 
marblk 30 CLOSE RELATIVE MARRY BLACK 
natrace 31 IMPROVING THE CONDITIONS OF BLACKS 
fechld 32 MOTHER WORKING DOESNT HURT CHILDREN 
fepresch 33 PRESCHOOL KIDS SUFFER IF MOTHER WORKS 
fefam 34 BETTER FOR MAN TO WORK, WOMAN TEND HOME 
fehire 35 SHOULD HIRE AND PROMOTE WOMEN 
health 36 CONDITION OF HEALTH 
polhitok 37 EVER APPROVE OF POLICE STRIKING CITIZEN 
polabuse 38 CITIZEN SAID VULGAR OR OBSCENE THINGS 
polmurdr 39 CITIZEN QUESTIONED AS MURDER SUSPECT 
polescap 40 CITIZEN ATTEMPTING TO ESCAPE CUSTODY 
polattak 41 CITIZEN ATTACKING POLICEMAN WITH FISTS 
news 42 HOW OFTEN DOES R READ NEWSPAPER 
tvhours 43 HOURS PER DAY WATCHING TV 
conpress 44 CONFIDENCE IN PRESS 
contv 45 CONFIDENCE IN TELEVISION 
natheal 46 IMPROVING & PROTECTING NATIONS HEALTH 
natcity 47 SOLVING PROBLEMS OF BIG CITIES 
natcrime 48 HALTING RISING CRIME RATE 
natdrug 49 DEALING WITH DRUG ADDICTION 
nateduc 50 IMPROVING NATIONS EDUCATION SYSTEM 
natfare 51 WELFARE 
pillok 52 BIRTH CONTROL TO TEENAGERS 14-16 
sexeduc 53 SEX EDUCATION IN PUBLIC SCHOOLS 
teensex 54 SEX BEFORE MARRIAGE -- TEENS 14-16 
affrmact 55 FAVOR PREFERENCE IN HIRING BLACKS 
wrkwayup 56 BLACKS OVERCOME PREJUDICE WITHOUT FAVORS 
racwork 57 RACIAL MAKEUP OF WORKPLACE 
discaff 58 WHITES HURT BY AFF. ACTION 
eqwlth 59 SHOULD GOVT REDUCE INCOME DIFFERENCES 
EFF911F 60 HOW EFFECTIVE R THINKS REDUCING AIR TRAVEL 
EFF911K 61 HOW EFFECTIVE R THINKS AVOIDING TRAVEL TO CERTAIN CITIES 
EFF911L 62 HOW EFFECTIVE R THINKS AVOIDING TALL BUILDINGS 
EFF911M 63 HOW EFFECTIVE R THINKS AVOIDING NATIONAL LANDMARKS 
region 64 REGION OF INTERVIEW 
vote04 65 DID R VOTE IN 2004 ELECTION 
age 66 AGE OF RESPONDENT 
class 67 SUBJECTIVE CLASS IDENTIFICATION 
educ 68 HIGHEST YEAR OF SCHOOL COMPLETED 
polviews 69 THINK OF SELF AS LIBERAL OR CONSERVATIVE 
partyid 70 POLITICAL PARTY AFFILIATION 
income 71 TOTAL FAMILY INCOME 
sei 72 RESPONDENT SOCIOECONOMIC INDEX 
race 73 RACE OF RESPONDENT 
rincome 74 RESPONDENTS INCOME 
sex 75 RESPONDENTS SEX 

Variables in the working file 
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Scroll to end of file: 
 

 
 
All variable names are in lower case except EFF911F, EFF911K, EFF911L and EFF911M on rows 61-
64.  All variable and value labels are in UPPER CASE except for the value labels of the same four 
variables, which are in Mixed Case.   
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abany       EFF911F 

 
This indicates to me that the file is of Mixed Parentage! 
 
I then ran John Peck's Python code: 
 

* This program capitalizes all variable and value labels and replaces words listed in the uppercase variable 
with their all-caps equivalent in variable and value labels. 
 
begin program.  
import spss, spssaux, re 
# terms to capitalize as free-standing words - list in uppper case 
# or whatever case variant is desired 
uppercase = ["IAP", "DK", "NA", "Christian", "Jew", "Jewish", "America", "Islam"]  
vd = spssaux.VariableDict()  
for v in vd:  
    varlabel = v.VariableLabel  
    if varlabel:  
        varlabel = varlabel.capitalize() 
        for w in uppercase: 
            sexpr = r"(?i)\b%s\b" % w 
            varlabel = re.sub(sexpr, w, varlabel) 
        v.VariableLabel = varlabel 
    vallbls = v.ValueLabels  
    for k in vallbls:  
        vallbls[k] = vallbls[k].capitalize() 
        for w in uppercase: 
            sexpr = r"(?i)\b%s\b" % w 
            vallbls[k] = re.sub(sexpr, w, vallbls[k]) 
    if vallbls:  
        v.ValueLabels = vallbls  
end program.  
display labels. 

 
SPSS hurtles through the file leaving the first letters of all labels in upper case, but changing everything 
except specified strings (eg IAP, DK, USA, America) to lower case.  You watch it all happening in the 
Information area. 
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This file is now much easier both to read and to work with, but first it is now extremely important to save 
my work!  First thing to do is to save the file with a new name: 
 
File > Save As 
 

Change babbie_all.sav to     babbie_all2.sav    

 

  
 

then click on Save 
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Check the value labels:  
 

  
abany      partyid 

 
It helps if you widen the Label column to see more of the text: 
 

 
 
. . and helps even more if we change the order of the columns so the useful ones are on the left.   
 
View > Customise Variable View allows you to reorder columns, hide the ones you don't want and even 
create new ones, but for now you can simply highlight the headers:  
 

 
 
and drag them to a new position: 
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Now do the same for the other columns, starting with Label: 
 

 
 

 
 
Values 
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Missing 

 

 
 
Scroll down the Value column to find the widest value label and widen the column to see all of it: 
 

 
 
. . and narrow the viewer until you have only the most important columns: 
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Scroll back to the top of the file: 
 

 
 
 
There remains some tidying up to do on the labels, to restore acronyms, proper names and other words 
which should have upper case first letters.  This can be done manually in the Data Editor, by using: 
 
 Data > Define Variable Properties   
 

(and saving the syntax with Paste  ) by writing new variable and value labels, or by finding all the 

qualifying words and adding them to the Python code.  At least there are only 75 variables to check.  The 
full gss2008.sav file has 843! 
 
File babbie_all2.sav now holds all variables from all three files.  The easiest way to recreate them, but 
with the new labelling, is to run the original SAVE OUTFILE commands again, but augment the *.sav file 
names to babbie_demo2.sav, babbie _exer2.sav and babbie _common2.sav.   
 
For now I'll work from babbie_all2.sav and think about re-ordering the variables to tally with the "Class 
Questionnaire" in Appendix B.  That way I'll be working from a single file. 
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babbie_all2.sav 

 
Variable Labels 

Variable Position Label 

id 1 Respondnt id number 
abany 2 Abortion if woman wants for any reason 
abdefect 3 Strong chance of serious defect 
abhlth 4 Womans health seriously endangered 
abnomore 5 Married--wants no more children 

abpoor 6 Low income--cant afford more children 
abrape 7 Pregnant as result of rape 
absingle 8 Not married 
chldidel 9 Ideal number of children 
marital 10 Marital status 
divorce 11 Ever been divorced or separated 
childs 12 Number of children 
obey 13 To obey 
popular 14 To be well liked or popular 
thnkself 15 To think for ones self 
workhard 16 To work hard 
helpoth 17 To help others 
sibs 18 Number of brothers and sisters 
attend 19 How often r attends religious services 
postlife 20 Belief in life after death 
pray 21 How often does r pray 
relig 22 Rs religious preference 
cappun 23 Favor or oppose death penalty for murder 
getahead 24 Opinion of how people get ahead 
homosex 25 Homosexual sex relations 
xmovie 26 Seen x-rated movie in last year 
premarsx 27 Sex before marriage 
gunlaw 28 Favor or oppose gun permits 
racdif4 29 Differences due to lack of will 
marblk 30 Close relative marry black 
natrace 31 Improving the conditions of blacks 
fechld 32 Mother working doesnt hurt children 
fepresch 33 Preschool kids suffer if mother works 
fefam 34 Better for man to work, woman tend home 
fehire 35 Should hire and promote women 
health 36 Condition of health 
polhitok 37 Ever approve of police striking citizen 
polabuse 38 Citizen said vulgar or obscene things 
polmurdr 39 Citizen questioned as murder suspect 
polescap 40 Citizen attempting to escape custody 
polattak 41 Citizen attacking policeman with fists 
news 42 How often does r read newspaper 
tvhours 43 Hours per day watching tv 
conpress 44 Confidence in press 
contv 45 Confidence in television 
natheal 46 Improving & protecting nations health 
natcity 47 Solving problems of big cities 
natcrime 48 Halting rising crime rate 
natdrug 49 Dealing with drug addiction 
nateduc 50 Improving nations education system 
natfare 51 Welfare 
pillok 52 Birth control to teenagers 14-16 
sexeduc 53 Sex education in public schools 
teensex 54 Sex before marriage -- teens 14-16 
affrmact 55 Favor preference in hiring blacks 
wrkwayup 56 Blacks overcome prejudice without favors 
racwork 57 Racial makeup of workplace 
discaff 58 Whites hurt by aff. action 
eqwlth 59 Should govt reduce income differences 
EFF911F 60 How effective r thinks reducing air travel 
EFF911K 61 How effective r thinks avoiding travel to certain cities 
EFF911L 62 How effective r thinks avoiding tall buildings 
EFF911M 63 How effective r thinks avoiding national landmarks 
region 64 Region of interview 
vote04 65 Did r vote in 2004 election 
age 66 Age of respondent 
class 67 Subjective class identification 
educ 68 Highest year of school completed 
polviews 69 Think of self as liberal or conservative 
partyid 70 Political party affiliation 
income 71 Total family income 
sei 72 Respondent socioeconomic index 
race 73 Race of respondent 
rincome 74 Respondents income 
sex 75 Respondents sex 

Variables in the working file 
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The very next day I found a link to the student support materials in my own review of the book!!: 
 
The link General Resources goes to a page with the following links: 
 

General Resources 
Data Sets 

 Exer 
 Demo 
 Local 

Comprehensive E-Appendixes 
 Appendix A: The Codebook 
 Appendix B: Questionnaire for Class Survey 
 Appendix C: The Research Report 
 Appendix D: Proposing New Research 
 Appendix E: SPSS Survey Tips 
 Appendix F: SPSS Commands 
 Appendix G: Recommended Readings 

o Cook B 
o Dantonio D 
o Glock A 
o REnzi C 

 Appendix H: Lab Answers 
 
I downloaded all the files to see how my efforts at recreating SPSS saved files compared with those in 
the book.  At this point I discovered that the files differed in both number of variables and number of 
cases. 
 
My versions in red below: 
 

File Cases Variables Notes 

demo.sav 1500 43 All labels in UPPER CASE 

babbie_demo.sav 2023 30 All labels in UPPER CASE 

   

 

exer.sav 1500 47 All labels in UPPER CASE 

babbie_exer.sav 2023 35 All labels in UPPER CASE 

   

 

local.sav None 49 No cases: all labels in lower case 

   

 

babbie_common.sav 2023 11 All labels in UPPER CASE 

babbie_all2.sav 2023 75 Composite file: labels changed to mixed case 

 

 
 
  

http://surveyresearch.weebly.com/babbie-halley-wagner-and-zaino-2013.html
http://www.sagepub.com/babbie7e/study/resources.htm
http://www.sagepub.com/babbie7e/study/resources/Datasets/EXER.sav
http://www.sagepub.com/babbie7e/study/resources/Datasets/DEMO.sav
http://www.sagepub.com/babbie7e/study/resources/Datasets/local.sav
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixA/Codebook.doc
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixB/QuestionnaireSurvey.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixC/AppendixC_Report.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixD/ResearchProposal.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixE/SPSSSurveyTips.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixF/SPSSCommands.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixG/Cook_B.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixG/Dantonio_D.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixG/Glock_A.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixG/REnzi_C.pdf
http://www.sagepub.com/babbie7e/study/resources/Appendixes/AppendixH/LabAnswers.pdf
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demo.sav 

 
Variable Labels 

Variable Position Label 

id 1 RESPONDNT ID NUMBER 
abany 2 ABORTION IF WOMAN WANTS FOR ANY REASON 
abdefect 3 STRONG CHANCE OF SERIOUS DEFECT 
abhlth 4 WOMANS HEALTH SERIOUSLY ENDANGERED 
abnomore 5 MARRIED--WANTS NO MORE CHILDREN 
abpoor 6 LOW INCOME--CANT AFFORD MORE CHILDREN 
abrape 7 PREGNANT AS RESULT OF RAPE 
absingle 8 NOT MARRIED 
age 9 AGE OF RESPONDENT 
attend 10 HOW OFTEN R ATTENDS RELIGIOUS SERVICES 
cappun 11 FAVOR OR OPPOSE DEATH PENALTY FOR MURDER 
childs 12 NUMBER OF CHILDREN 
chldidel 13 IDEAL NUMBER OF CHILDREN 
class 14 SUBJECTIVE CLASS IDENTIFICATION 
divorce 15 EVER BEEN DIVORCED OR SEPARATED 
educ 16 HIGHEST YEAR OF SCHOOL COMPLETED 
getahead 17 OPINION OF HOW PEOPLE GET AHEAD 
gunlaw 18 FAVOR OR OPPOSE GUN PERMITS 

helpoth 19 TO HELP OTHERS 
homosex 20 HOMOSEXUAL SEX RELATIONS 
income 21 TOTAL FAMILY INCOME 
marblk 22 CLOSE RELATIVE MARRY BLACK 
marhomo 23 HOMOSEXUALS SHOULD HAVE RIGHT TO MARRY 
marital 24 MARITAL STATUS 
natrace 25 IMPROVING THE CONDITIONS OF BLACKS 
obey 26 TO OBEY 
partyid 27 POLITICAL PARTY AFFILIATION 
polviews 28 THINK OF SELF AS LIBERAL OR CONSERVATIVE 
popular 29 TO BE WELL LIKED OR POPULAR 
postlife 30 BELIEF IN LIFE AFTER DEATH 

pray 31 HOW OFTEN DOES R PRAY 
premarsx 32 SEX BEFORE MARRIAGE 
racdif4 33 DIFFERENCES DUE TO LACK OF WILL 
race 34 RACE OF RESPONDENT 
relig 35 RS RELIGIOUS PREFERENCE 
rincome 36 RESPONDENTS INCOME 
sei 37 RESPONDENT SOCIOECONOMIC INDEX 
sex 38 RESPONDENTS SEX 
sibs 39 NUMBER OF BROTHERS AND SISTERS 
thnkself 40 TO THINK FOR ONES SELF 
workhard 41 TO WORK HARD 
xmovie 42 SEEN X-RATED MOVIE IN LAST YEAR 

wtssnr 43 WEIGHT VARIABLE 

Variables in the working file 
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exer.sav 

 
Variable Labels 

Variable Position Label 

affrmact 1 FAVOR PREFERENCE IN HIRING BLACKS 
age 2 AGE OF RESPONDENT 
class 3 SUBJECTIVE CLASS IDENTIFICATION 

conpress 4 CONFIDENCE IN PRESS 
contv 5 CONFIDENCE IN TELEVISION 
discaff 6 WHITES HURT BY AFF. ACTION 
educ 7 HIGHEST YEAR OF SCHOOL COMPLETED 
eff911f 8 HOW EFFECTIVE R THINKS REDUCING AIR TRAVEL 
eff911k 9 HOW EFFECTIVE R THINKS AVOIDING TRAVEL TO CERTAIN CITIES 
eff911l 10 HOW EFFECTIVE R THINKS AVOIDING TALL BUILDINGS 
eff911m 11 HOW EFFECTIVE R THINKS AVOIDING NATIONAL LANDMARKS 
eqwlth 12 SHOULD GOVT REDUCE INCOME DIFFERENCES 
fechld 13 MOTHER WORKING DOESNT HURT CHILDREN 
fefam 14 BETTER FOR MAN TO WORK, WOMAN TEND HOME 
fehire 15 SHOULD HIRE AND PROMOTE WOMEN 
fepresch 16 PRESCHOOL KIDS SUFFER IF MOTHER WORKS 
health 17 CONDITION OF HEALTH 
id 18 RESPONDNT ID NUMBER 
income 19 TOTAL FAMILY INCOME 
natcity 20 SOLVING PROBLEMS OF BIG CITIES 
natcrime 21 HALTING RISING CRIME RATE 
natdrug 22 DEALING WITH DRUG ADDICTION 
nateduc 23 IMPROVING NATIONS EDUCATION SYSTEM 
natfare 24 WELFARE 
natheal 25 IMPROVING & PROTECTING NATIONS HEALTH 
natrace 26 IMPROVING THE CONDITIONS OF BLACKS 
news 27 HOW OFTEN DOES R READ NEWSPAPER 
partyid 28 POLITICAL PARTY AFFILIATION 
pillok 29 BIRTH CONTROL TO TEENAGERS 14-16 
polabuse 30 CITIZEN SAID VULGAR OR OBSCENE THINGS 
polattak 31 CITIZEN ATTACKING POLICEMAN WITH FISTS 
polescap 32 CITIZEN ATTEMPTING TO ESCAPE CUSTODY 
polhitok 33 EVER APPROVE OF POLICE STRIKING CITIZEN 
polmurdr 34 CITIZEN QUESTIONED AS MURDER SUSPECT 
polviews 35 THINK OF SELF AS LIBERAL OR CONSERVATIVE 
race 36 RACE OF RESPONDENT 
racwork 37 RACIAL MAKEUP OF WORKPLACE 
region 38 REGION OF INTERVIEW 
rincome 39 RESPONDENTS INCOME 
sei 40 RESPONDENT SOCIOECONOMIC INDEX 
sex 41 RESPONDENTS SEX 
sexeduc 42 SEX EDUCATION IN PUBLIC SCHOOLS 
teensex 43 SEX BEFORE MARRIAGE -- TEENS 14-16 
tvhours 44 HOURS PER DAY WATCHING TV 
vote04 45 DID R VOTE IN 2004 ELECTION 
wrkwayup 46 BLACKS OVERCOME PREJUDICE WITHOUT FAVORS 
wt2008nr 47 WEIGHT VARIABLE 

Variables in the working file 

 
[NB:  The weight variable wt2008nr is not in file GSS2008.sav] 
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local.sav (empty except for metadata) 

 
Variable Labels 

Variable Position Label 

id 1 id 
age 2 age 
gender 3 gender 

class 4 year in school 
livewith 5 where do you live 
fratsoro 6 frat or soro member 
athletic 7 activ:athletics 
religion 8 activ:religion 
parties 9 activ:parties 
drinks5 10 binge drink 
drinks4 11 binge drink:4 
lastdrnk 12 last drink when 
getdrunk 13 # of drinks to get drunk 
hangover 14 drink prob: hangover 
mssclass 15 drink prob: miss a class 
getbehnd 16 drink prob: fall behind 
regret 17 drink prob: cause regret 
forget 18 drink prob: forget 
argue 19 drink prob: arguement 
unplansx 20 drink prob: unplanned sex 
unsafesx 21 drink prob: unsafe sex 
damage 22 drink prob: vandal 
police 23 drink prob: police 
injury 24 drink prob: injury 
overdose 25 drink prob: OD 
selfrate 26 Alcohol drinking habits: self rating. 
insult 27 sec alc:insult 
quarrel 28 sec alc:arguement 
assault 29 sec alc: assault 
vandal 30 sec alc:vandal 
babysit 31 sec alc:babysit 
disruptv 32 sec alc:disruptive 
propostn 33 sec alc:proposition 
daterape 34 sec alc:date-rape 
usegrass 35 drug use:marijuana 
cigarett 36 drug use:cigarettes 
hadsex 37 sexual intercourse 
sexpartn 38 # of sexual partners 
friends 39 number of close friends 
gpa 40 GPA 
hrsstudy 41 time at activity:studying 
hrssoclz 42 time at activity:socialize 
hrssport 43 time at activity:athletics 
race 44 Race 
hsbinge 45 hs drink:binge 
famattd 46 family attitude reg alc 
drinkcat 47 Levels of drinking and binging 
probgulp 48 frequent bingers with 5+ problems 
collbing 49 Students binge in College 

Variables in the working file 

 
 


